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Reviewer Portal URL

When you email support@ecivis.com to publish your grant program, you will be notified
when it is available and also sent the link to access the reviewer portal.

Example: https://webportalapp.com/portal/applications _example

Once you have added your reviewers and assigned applications appropriately this link can
be distributed to the reviewers to begin the review process.

Adding and Removing Reviewers

Reviewers can be added any time from Grant Network.

A. Log into Grants Network, and from the Grants Management tab, select Subrecipient
Management:

L Your taols for grants success. Grant Management Grant Research Insight Reports Administration

Project Dashboard

Research Project Search Insight

Find Grants My Projects Best Practices and More
Project Calendar
e . Create Project T . _ -
Organization Activity Summary anization Dashboard » My Action Items

Organization Documents
Open Applications icati Post Award Tasks (Next 7 Days)
Projects Due i ETLEL W EREG IS Reports Due

Mo pending items in next 7 days.

14 4 0 8 0

Past Due ltems

1 | Ball Park Lighting
1 | Clean Air Buses
1 | GTR101 Federal Transit Formula

B. Selé_ét to edit the ébr.;ropriate program:
Programs
Click to filter:

Arizona 9-1-1 Grant Program-FY2020 - $18,500,000.00 total funding
Department: ADA - Office of Grants and Federal Resources

Arizona Grain Research and Promotion Council - FY20 - $21,000.00 total funding

Department: AHA - Agri Consultation and Training

WView detail
Arizona Iceberg Lettuce Research Council - FY20 - $90,800.00 total funding Edit
Depart t: AHA - Agri Conzultation and Training

Preview Application
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C. Select the Review tab, then Add Reviewer:
Solicitation Edit

e Revien

Step 6 of 7 ™ = Required for Section Completion

3¢ =Incomplete # = Completed

Please enter review committee members:
Review notes may be used to provide instructions to your customer service
representative that will help them in designing the application and submission
process for your solicitation. Once you have marked your solicitation
complete, your customer serice representative will follow up within one
business day to confirm your program details. These notes will not appear to
applicants.

Review Committee

David Shea dshea@ecivis com i

Anthony Torres atorres{@ecivis.com

=

Kelly Young kyoung@ecivis.com | |@Source B @@ B I U . H@ |

Add Reviewer ) Add Peter to the workspace. He will be editing the application after

reviewing its appearance to applicants.

How is the review team notified when applications are submitted? They
will be reviewing as they are submitted and not on a specific date.

| )

(@ Use the tabs to complets the soliditation. Naske sure to dlick Ssve when making changes

Save ) Done )

a. Complete the form and select Add Reviewer:

Add Reviewer b 4

First Mame-™

Heliy

Last Mame:™

Young

Email™*

kyoung(@ecivis.com

Add Reviewer ) Close )
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b. Users can be deleted by clicking on the red trash icon in the Review Committee
box:

Please enter review committee members:

Review Committee

David Shea dshea@ecivis.com
Anthony Tarres atorres(@ecivis.com )
Kelly Young kyoung@ecivis.com i

Add Reviewer )

D. From the Review tab, select Save:
Solicitation Edit

EEY Revies

Step6of 7 " =Required for Section Completion

3 = Incomplete 4 = Completed

Please enter review committee members:
Review notes may be used to provide instructions to your customer senice
representative that will help them in designing the application and submission
process far your solicitation. Once you have marked your salicitation
complete, your customer senice representative will follow up within one
business day to confirm your program details. These notes will not appear to

Review Commitiee

David Shea  dshea@echis com & oty
Anthony  Tomes  stomes@ecivis.com B
Kelly Young  kyoung@ecivis.com & Bsowes B B @B I U | = £ = =

Add Peter to the workspace. He will be editing the application after

Add Reviewer
} reviewing its appearance to applicants.

How is the review team notified when applications are submitted? They
will be reviewing as they are submitted and not on a specific date.

L )

@ Use the tabs o complete the solcitation. Make sure o cick Sav aking changes,

Done )

Reviewers added in Grants Network will automatically be imported into the Zengine
Workspace.

Assigning Applications to Reviewers

1. To assign applications to reviewers, select the Program Manager flag icon at the top

of the page and on the following page select Edit Assignment:

Applications Profile

+Add Appiication T i View » | profileLink v Searct Q =

Dragat

. profileLink Application/Project Title Project Goals and Objectives Scope of Work

Updated 7/16/2019



B8 Review

< Reviews m—p = Edit Assignments

2. Assignments can be made by submission, group, or member. Select the method of
assignment in the top left corner:

() Assign by Submission v e

[3 Assign by Submission +

£ Assign by Submission Group ol
& Assign by Member #ASSIGNMENTS ~ & COMPLETED -~ | % COMPLETED ~
¥ Batch Assign 0 0 N/A
Standley Creek Sediment Reduction Project 1 1 100%
Underground Storage Tank Program 1] 0 NSA
‘Water Purification 1 o 0%

3. After selecting your assignment method, choose the submission, group, or member
on the left side and the submission, group, or member it will be assigned to on the
right:

& Assign by Member ~

Q. Search Members T Al

MEMBER ~ #ASSIGNMENTS ~ # COMPLETED ~ % COMPLETED = )
Baird , Ryan

Baird , Ryan o 0 N/A

Brayer , Jason 0 0 N/A Underground Storage Tank Prog|
Riverside Park Rer  Water Purffication

Del Rosario, Edgar bl 0 WA

Reopening a review

1. Toreopen a review that has already been submitted, go to the Review tab. Select
the review you need to change:
(@7 (L] }

DEFAULT = = (]

[T Forms we use » ] Budgets Reviews ‘-!Ell!we's 0 More = E|
+Add Review X i ‘iew: Group by Reviewer - Justification ~ Search Q = Please Show ID Column 1

Grouped by:

Application - 1. : Have you uploaded your Upload ¢
I Application/Project Title = R . i conflict of interest form?

4_rbaird@ecivis.com

+  Uncategorized Test Project rbaird@ecivis.com Yes |
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2. Next, on the top right hand side of the page select Revert to Draft:
5776786 ﬁ Revert to Draft

& B Uncategori.. = E

Have you uploaded your conflict of interest form?

Yes

Is there a conflict of interest on this review?

No

Reviewing Feedback/Scores

There are two primary forms where you can begin reviewing each reviewer’s application
feedback and scores.

1. First, select the Review form. This form contains the feedback and category scoring
submitted by the reviewer for each application they were assigned to review.

o01ewrHF~ I @ # 0 ® F 49 A B L H

pplications Budgets Reviewers O vore~

1] View = | Justification ~ Search Q =

Drag a column header here and drop it to group by that column.
Have you uploaded your Upload conflict of interest | Is there a conflict of interest Can you still objectively Justificatio
conflict of interest form? form on this review? perform this review?

2. The default view is to group reviews by status (not started, in progress, or
submitted). However, you can regroup by application and by reviewer. To change
your view click on the View dropdown menu and select the desired view:
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Grouped by:

4 Not Started

4 |nProgress

4 Submitted
Submitted
Submitted

View: By Status = Wm ~ Search

By Application
By Reviewer
By Status

Manage Views

submissionLink

@

&
Howard Basin Cleanup & |53 10
Standley Creek Sediment Reduction Project & 31 6

Total | Programmatic
Score Narrative

3. The applicant’s total score can be seen in the Total Score column. Use the bar at the

bottom to scroll left

10. Program Specific Criteria

#3 (Organization Capability)

and right:

no previous projects listed, ... 76

Mo previous project specifi.. | 79

e on

Mountain Club Hazardous & Hu

Mountain Club Hazardous & | Elli

Rl i Pl Hlamnednea =~ | e

4. The second form to review is the Application form. On the Application form each
applicant’s average score is included at the bottom of each record. Use the bar at the

bottom to scroll left

and right:

I ForANerE ForpenEs e

2018 WFHF Spri Ltrs-OFD.p...  74.14
PNF Letter of Support.pdf 76.00

69.86

Letters of support.pdf 77.86
58.17
Letters of Support.pdf 78.00

Making an Award

o o o o o o

R N R IR

o o o o o o

0.00
0.00
0.00
0.00
0.00
0.00

*The subrecipient will not be notified of their award until the Award Recommendation
Approval task has been completed. They will see their application as Under Review in their

Portal.

1. After you have completed the review/scoring process and have determined who
receive an award, select the application to be awarded:
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3.

+Add Application T

Grouped by:

1] View: Submissions By Folder - profilelink ~ Search Q =

4 Under Review

projectTitle 4, Scope of Work .

4 | Under Review kyoung@ecivis.com & Workforce Development - ... | The County of Jay Health D...
Under Review kyoung@ecivis.com & REGION 5 WORKFORCE DE... | 1.Further work to more ful...
4 | Under Review jdelarorsa@ecivis.com @ Teston Kelly's Account Test
Under Review atorres@ecivis.com & | Job Incubator The grant will only fund a p...
4 | Under Review epistemehayes@gmail.comy  Brewery School Creating a brewery school t..

Under Review

jbrayer@cox.net &

Youth Employment Educati... | Contract staff to teach clas...

Select the folder drop down and change Under Review to Awarded*:

12 M
3 yea
Test

It will
5 Mol

24w

REGION 5 WORKFORCE DEVELOPME...

= & UnderRevi.. m E

Profile

kyoung@ecivis.com

1. Application/Project Title

REGION 5 WORKFORCE DEVELOPMENT

[Eearch Folders

Uncatagorized
Draft

Under Review
Danisd
Awarded

At the bottom left of this window, click Save [Appl/catlon namey.

B T e P P I s - .-.n.-ll-l-..-.l-.-..ll T PN N SR $m b

5. Project Timeline

3 years - see attached

Save REGION 5 WORKFORCE.. +

Log into Grants Network and from the Grant Management tab, select
Subrecipient Management:
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by Arizona | Help / Training | Logout

Grant Management Grant Research Reports Administration

Project Dashboard
Research Project Search Insight
Find Grants My Projects Best Practices and More
Project Calendar
Organization Activity Summary facede Bioy janizafion Dashboard » My Action ltems View Task List »
Organizafion Documents
Applicati Post Award

Projecis Due Subrecipient Management | BEE RIS

Tasks (Next 7 Days)
Mo pending items in next 7 days.

10
Past Due ltems

Mo past due items.

From the list of programs, select the program and “View Detail”:

Workforce Development Program (WDP) Grant - FY 2019 - §1,250,000.00 total funding
Department: Workforce Development

View detail

Edit

| Preview Application |

The applicant that was moved into the Awarded folder in Zengine will now

appear under Pending Awards Awaiting Recommendation:
Program Detail

Workforce Development Program (WDP) Grant - FY 2019

Department: Workforce Development
Total Funding: $1,250,000.00
Application Period: 01/14/2019 - 08/31/2019

H Preview Application ' | Ext. Solicitation Listing & | Application Workspace &'

Award Recommendation Approval

ou currently have no pending recommendation approvals. Click the reload button fo refresh.

Reload
Search:
Pending Awards Awaiting Recommendation
Project Recipient Name Action =
Brewery School Jeff Winger Create Recommendafion
Job Incubator Ulysses Grant Create Recommendation
Government Organization Workforce Development Program David Shea Create Recommendafion
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7. From the row of the appropriate applicant, select “Create Recommendation”:

Search:
Pending Awards Awaiting Recommendation
Project Recipient Name Action =

Brewery School

Jeff Winger Create Recommendation

Ulysses Grant Create Recommendafion

David Shea

Job Incubator

Government Organization Workforce Development Program Create Recommendation

8. Complete all available information on the following page:

Award Recommendation Approval Task Creation

Recipient:  Ulyszes Grant
Application:  Job Incubator

External Note:* Congratulafions! We are pleased to inform you that your application has been accepted. We are still in the process

of reviewing other potential recipients. We will send out further instrucfions for you once all subrecipientshave
been approved.

For any questions, please email supporti@organizafion. com.

P
638 characters remaining.

Internal Note:* Application meets all requirements, excesds the minimum score of 130 points, and was recommended by all
revieveers. Please review for approval.

4
858 characters remsaining.

EIN: %
a. Note that the External Note will be viewable
Internal note will be for Approver use only.

Award Number: | vy nasnqg.nnd

by the Subrecipient. The

Edit the Award Recommendation Total, by identifying each distribution per
funding source:

Allocate Funding:

Total Funding Funding Available Subrecipient Award

General Fund Fv19 - Workforce

$ % | 40,000.00
Development

Award Total

a. Toreview or revise the applicant’s budget select Award Budget.
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10.0nce you have completed all fields, select Send for Approval.
File Name L Uploaded Date File Size Actions

Mo files have been uploaded

Showing 0 to 0 of 0 entries
Previous Mext

Send for Approval Cancel

11.0nce the recommendation has been created, the applicant will have been
moved on the Program Detail page from the Pending section to the Award

Recommendation Approval section:
Frogram vertall

Workforce Development Program (WDP) Grant - FY 2019

Department: Workforce Development
Total Funding: $1,250,000.00
Application Period: 01/14/2019 - 08/31/2019

E Preview Applicaion & | Ext Solicitation Listing (&' | Application Workspace &'

Search:
Award Recommendation Approval
Project Recipient Name Award Approved Links v
Job Incubator Ulysses Grant 540,000.00 Award Package | Application
Showing 1 fo 1 of 1 entries
Reload Approve Reject
Search:
Pending Awards Awaiting Recommendation
Project Recipient Name Action =

Making a Denial

1. After you have completed the review/scoring process and have determined who will
not be awarded, open the Denials form.

[C) Forms we use v_:‘: Applications Budgets Reviews Reviewers O vore~ *&
+Add Application R 4 1 View = | profileLink ~ Search Q | | - ‘

Drag a column header here and drop it to group by that column.

Awards

2. Program/Project
profileLink 1. Application/Project Title | Congressional District (chec Denials ‘—
all that apply) .
: 2 Profile
= = a
contact@faithsolutions2mez. Mental Health Ministry Vol... | 8 Applicants
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2. Select the Add Denial button on the top left side of the page to begin entering a
denial.

Applications Budgets Reviews Reviewers Denials =

Denial *h- n submissionLink ~ Search Q =) # Form Tools

Sorry, but there are currently no records in this workspace.

3. On the Denial form, complete the following fields:

e Submission: Select the application you want to deny
o External Message: Enter a message for the applicant

4. After all applicable fields have been updated, select Save New Denial at the
bottom of the form.

External Message

Save New Denial + -‘—

5. After saving the new denial, an email will be sent to the applicant notifying
them of the denial including the External Message.
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